Today's technological innovations have empowered small businesses to do things that would have been utterly unimaginable even 15 years ago. To remain competitive in a constantly shifting landscape, we've become more dependent on software and hardware to house even the most basic structures of the companies we run.

Meanwhile, these technologies are evolving at breakneck speed. Every day, there’s a slew of new devices to consider, a pile of new updates to install and a new feature to wrap our heads around. Every morning, we wake up and the digital world is thrillingly new.

But all over the world, there’s an insidious network of criminals keeping up with this insanely rapid pace of progress. With every new security measure designed to protect our digital assets, there are thousands of hackers working around the clock to determine a new way to break through. An estimated 978,000 fresh new malware threats are
released into the world each day. The term “up to date” doesn’t mean much anymore in the wake of new developments arriving minute by minute.

There’s a price to pay for the increased efficiency and reach enabled by the digital age. We’ve all heard the story before. A massive, multinational corporation neglects some aspect of their security and falls victim to a crippling large-scale cyberattack, with criminals lifting millions of dollars in customer data and digital assets. Equifax, J.P. Morgan, Home Depot, Yahoo!, Verizon, Uber and Target – these narratives are so commonplace that they barely raise an eyebrow when we read about them in the news.

Most business owners wrongly assume that these incidents have no bearing on their own companies, but these high-profile incidents account for less than half of data breaches. In fact, according to Verizon’s 2017 Data Breach Investigations Report, 61% of attacks are directed at small businesses, with half of the 28 million small and medium-sized businesses (SMBs) in North America coming under fire within the last year.

It’s hard to imagine how you can possibly protect yourself from these innumerable threats. Statistically, you can be all but certain that hackers will come for your data, and there’s no way to know what new tool they’ll be equipped with when they do.

You may not be able to foresee the future, but you can certainly prepare for it. With research, education and resources, you can implement a robust security solution into the fabric of your business. That way, you can send hackers packing before they get their hooks into the organization you’ve spent years building from the ground up.

One huge leap you can make right now for the security of your business is to simply realize that cyber security isn’t something you can install and leave alone for years, months or even days. It requires regular updates and the attention of professionals to ensure there’s no gap in your protection. There are new shady tactics being used by criminals every day, but there are also fresh protocols you can use to stave them off.

Small business owners assume that since they don’t have the resources of a Fortune 500 company, they don’t have the means to invest in anything but the barest of security. Obviously, hackers know this and target SMBs in droves. The bad news is that most businesses’ paper-thin barriers won’t save them in the event of a crisis. The good news is that it doesn’t take thousands upon thousands of dollars to implement a security system that will send the hackers packing.

---

How Does Your I.T. Company Compare?

Our April 2018 Service Key Performance Indicators

![Emoji](emoji.png)

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 Business Hour</td>
<td>93%</td>
</tr>
<tr>
<td>Ticket Resolution</td>
<td></td>
</tr>
<tr>
<td>Client Satisfaction</td>
<td>96%</td>
</tr>
<tr>
<td>Average Response Time</td>
<td>5 mins</td>
</tr>
</tbody>
</table>

Get More Free Tips, Tools and Services At Our Website: www.b4networks.ca
4 Tips To Ensure Fear Won’t Destroy Your Business

Fear can be a good thing if it keeps us from stepping too close to the edge of a cliff or motivates us to dodge out of the way of a speeding car. But in business, you shouldn’t let fear dictate the core of your decision-making process. Here are four ways to manage your fear, move through it and make the best possible calls for the future of your company.

1. DO A COST-BENEFIT ANALYSIS.

It’s the oldest and easiest trick in the book. Make a list with two columns – one that includes everything you worry could go wrong in your organization, and the other with everything you hope will go right. Taking a step back and looking at this list will help you avoid surrendering to fear at the offset and make your decisions based on facts instead.

2. FIND YOUR SPOCK AND MCCOY.

Any classic Star Trek fan will remember that whenever Capt. James T. Kirk had to make a decision, he gathered his two most trusted advisors: Dr. McCoy and Spock. He could always count on McCoy to offer a “gut” perspective based on emotion and fear, whereas Mr. Spock consistently offered a measured, logical approach to any situation. Then the captain, better understanding the extremes of the situation, could make a level-headed decision. Find the members of your team who will help you see the full spectrum of any situation, listen to them and make decisions accordingly.

3. TRUST, BUT VERIFY.

When Ronald Reagan spoke about his decision-making process for the nuclear-arms policy and the United States’s relationship with the Soviet Union, he took a balanced approach. Though he said he would “trust” that the Soviets would abide by their agreement, he would “verify” that they were indeed holding up their end of the bargain.

To be a great leader, you need to have a certain level of faith that things are going right. However, you’ve also got to pay attention, verify that people are doing what you’ve asked them to do and make appropriate changes along the way to ensure that your trust is respected and warranted.

4. BUTTERFLIES ARE A GOOD THING.

My daughter Madison is an actor, and she has the proverbial butterflies in her stomach before every performance. In many ways, it’s the fuel that drives her onstage. As a leader, don’t let the butterflies in your stomach stop you from moving forward with a decision or from considering a new idea. Instead, let that little bit of anxiety motivate and drive you toward success.
3 Big Trends Businesses Need To Adopt Now

When the online publication Small Business Trends surveyed nearly 500 small and midsize-business owners across the country last February, they found that technology has become more important than ever in companies of all sizes.

Though CRM is often an expensive and lofty goal for time-strapped businesses, it dramatically increases growth once it’s implemented and understood. In fact, Small Business Trends found that “growing SMBs are twice as likely as their stagnant counterparts to rely on CRM in their daily lives.” Along with these cohesive programs, synchronizing business data across platforms is becoming a priority as well, especially when providing a holistic view of key customer information.

Even artificial intelligence has begun to crop up in the small business market, albeit slowly. Still, it’s clear that the fastest-growing businesses are using automation and predictive sale forecasting nearly twice as much as their stagnant counterparts.

SmallBusinessTrends.com, 2/14/18

The Internet Of Things: Are You Okay Playing Offense?

Adjusting your home’s thermostat and hot water heater back to normal temperatures as you board a plane on your way home isn’t just cool, it’s incredibly handy. However, the network of these and other connected devices – often called “the Internet of Things” (IoT) – poses one of the biggest security problems of the modern era.

Most people think about changing their computer password regularly and their ATM PIN occasionally, but they almost never consider changing the password the programmable thermostat ships with from the factory, meaning that anyone who can access the manual has access to your thermostat.

Usually, attackers who target IoT devices don’t want to cause you a problem. Instead, they use your device along with 20,000 other thermostats as “soldiers” to battle against a website or e-mail server. By flooding these sites with traffic, they can shut them down or stop your e-mail server from delivering your messages.

You should adopt a strict offensive posture against these types of threats in your life and business. If there is even a suspected problem with one of your IoT devices, pull the plug. Your heater may be cold when you get home, but at least your data will be safe.

Don’t take our word for it. Here’s what a client is saying about us:

“Make the move! I have dealt with other IT service providers and B4 is by far the most reliable - they know their stuff! B4 Networks has been very responsive to our needs and is proactive in ensuring the operation and security of our IT.”

Leslie Frenke, CEM Engineering

Get More Free Tips, Tools and Services At Our Website: www.b4networks.ca
Do You Know Someone That Needs Computer Support?

In our opinion, referrals from very happy clients and their employees are the greatest form of flattery. We love it when you’re so pleased with our services, that you’re willing to recommend us to other business owners you have a relationship with!

If you know someone who is looking for computer support for their company, you will receive $100 for every referral you send our way.

If your referral becomes one of our managed clients, you will receive a cheque up to the amount of one month of their signed agreement. That could be up to $5000 in your own pocket!

For full details about our referral program and to submit your referral, please visit www.b4networks.ca/referral-program today and get us in contact with your friends today!

Client Spotlight: FENA Insurance Solutions

Founded in 2006, FENA Insurance Solutions Inc. has become a leading property and casualty insurance brokerage in the region. FENA offers innovative insurance solutions to protect consumers’ businesses, commercial properties, homes and cars.

At FENA, they help safeguard your hard-earned assets whether at home, work or play. They are driven to succeed and are inspired by their belief that clients deserve the best service, value, expertise .. Inspired by excellence is what they believe makes FENA different.

Highlights of the Month

May 1 • International Workers’ Day
May 3 • Password Day
May 4 • Star Wars Day
May 5 • Cinco de Mayo
May 9 • Receptionists Day
May 13 • Mothers Day
May 18 • Pizza Party Day
May 24 • Brothers Day
May 28 • Amnesty International Day
May 31 • No Tobacco Day
The new Outlook 2016 has incorporated some cool features, designed to be helpful and make your work day a little smoother. It can look a bit different depending on what version of Outlook you're using and how your admin sets it up.

What's New in Outlook 2016?
When you open Outlook, you'll see six areas. Across the top is that familiar ribbon we've all become used to seeing. Above the ribbon, you'll find the Title Bar which has the File tab, Home tab, Send/Receive, Folder, and View. Across the main section, you'll find four wide panes of varying widths. Across the bottom is the newest addition to Outlook, the navigation bar.

While on the home tab, you can take a closer look at the four panes or main sections. The narrowest one located on the left contains your inbox, sent, deleted and other items pertaining to your mail folders. The second column contains your messages. Here, you can get a closer look at the items in your inbox. It shows the names and dates of each email. The widest pane shows the contents of the actual email. This section is called the reading pane. If you click on a specific email, you can read it and reply or forward it. The fourth smaller pane to the right contains your calendar and do-to-list.

At the bottom, you'll see the newly added navigation bar. Hover over each item there for a closer look. This is handy because you can access frequently used features or people very quickly here. The dots, which represent “more”, open up a “navigation options” dialog box. There you can change a number of things pertaining to the way your email client is laid out. You can also choose navigation options > compact navigation. This will make the navigation bar smaller. Little icons replace the larger words that were used. The icons can run horizontally across the bottom or vertically along the side.

Reading Pane Too Small?
You may not always need your calendar to stay open. It's easy to close. Simply click on the arrow at the top to close it. You can also close the folders section located on the far left the same way. By closing these two sections, you'll now have a much wider email viewing pane. This can be helpful if you have a long or important email to read. If you need to take a quick look at the folders, simply click on the words “All Folders” (far left side, vertically written) and a handy pop-out appears. This pop-out will stay there until you click on “All Folders” again. The navigation pane appears vertically written as well and this configuration can give you the greatest amount of space to work on emails.

In addition, you have the option of manually dragging the borders for each section. This is a quick and easy way to increase or decrease the width of a pane so that your Outlook email works best for your situation.

The New Navigation Pane
In the 2016 version, a navigation pane was added to the bottom. It has links that go out to:
- Mail
- Calendar
- People
- Tasks
- More – More is represented by small dots in most programs now.

You can hover over each one to learn more about it or access that particular feature. For instance, hover over “People” to see all those...
listed in your contact list. You can also hover over a specific person to get more information about this person. For each of your contacts, you’ll see small icons along the bottom so you can email, call or video chat with that person. The same is true for each item in the Navigation Pane. Simply hover over your calendar for a quick look at your day, week or month. The calendar in your Navigation Bar performs the same tasks as the actual calendar portion of your Home Page. For that reason, you may find it handy to just leave that Calendar closed and use the one in the Navigation Bar. This will give you more room for emails and other tasks you do on the Home Page.

**Taking a Deeper Look at The Ribbon**

The Ribbon has been around since Word 2007 and most users are fairly knowledgeable about how to use it. If it’s in the way and you’d like to temporarily remove it, click on the small triangle on the far right side of the page. This collapses the Ribbon. When you want it back, click on the same triangle and it reappears. This works for all Microsoft Office programs, including Word, Excel, and Access.

Of course, there are shortcuts for just about all the actions found on the Ribbon. Many users find it helpful to learn those shortcut keys and use them instead of navigating through the tabs/items on the Ribbon. You can also hide or view the Ribbon by clicking on the View tab. Outlook 2016 is all about making your email tasks much simpler.

**Dealing with Emails**

Once you get your work area set up so that it’s most efficient for you, it’s time to read and answer a few emails. At the top of each one, you have inline options to reply, reply all, forward or IM. Click on reply and you can just start typing your message. You can also right-click in this area for a list of other options like changing the font and color of your typing. Right-clicking in various areas of the page will always call up a list of other helpful options and this can often prevent you having to reopen the Ribbon to accomplish a task.

When an email has attachments, you can click on the attachment to view it there in the Outlook program. This is true for PDF docs, Word docs, and Excel. This saves you the trouble of having to open Word, Excel or Adobe and this can be a real time-saver. If you do want to open up the specific program and view the document there, simply double click on the attachment.

**Show As Conversation**

Another helpful feature when dealing with lots of emails from different people on the same topic is the “Show as Conversation” feature found on the View tab. By clicking on “Show as Conversation” you can group all the emails about a specific topic so that they make sense. This prevents you from having to sort through dozens of emails to find all those related to a topic. Once these emails are grouped together, it’s easy to click on one to read or respond to it.

**The Clean Up Tool**

Like many users, you may have a dozen emails on one specific topic and yet only five of them are actually important and contain good information. The Cleanup Tool can be used to remove those emails that only say something inconsequential like, “I agree” or “Thanks” or contain redundant information. The Cleanup Tool is found on the home page and hovering over it will show three options:

1. Clean up conversation
2. Clean up folder
3. Clean up folders and subfolders

Before the messages are cleaned up, you will get a warning box that asks if you’re sure. Many users find it helpful to clean up messages and folders on a regular weekly basis. This can prevent you from maxing out your Outlook storage limit. Simply run the Clean Up tool each week on folders and emails to keep redundant items from clogging up the works.

These are just a few of the many ways to make Outlook 2016 work more efficiently. By learning these tips and tricks you can save valuable time throughout your day and reduce stress.
### Top 10 Outlook Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compose</td>
<td>Ctrl + Shift + M</td>
</tr>
<tr>
<td>Send</td>
<td>Alt + S</td>
</tr>
<tr>
<td>Delete</td>
<td>Ctrl + D</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl + A</td>
</tr>
<tr>
<td>Send/Receive</td>
<td>F9</td>
</tr>
<tr>
<td>Go To Mail</td>
<td>Ctrl + 1</td>
</tr>
<tr>
<td>Go to Calendar</td>
<td>Ctrl + 2</td>
</tr>
<tr>
<td>Search</td>
<td>Ctrl + E</td>
</tr>
<tr>
<td>New Appointment</td>
<td>Ctrl + Shift + A</td>
</tr>
<tr>
<td>Check Spelling</td>
<td>F7</td>
</tr>
</tbody>
</table>